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Abstract

The purpose of this thesis was to create a knowledge base that newcomers to virtual reality game
development could use as an introductory guide to effectively reduce the learning curve and time spent
upskilling on the Unity game engine. All accessible game development tutorial formats were
investigated, with the most effective and relevant tutorials used as external resources in the knowledge
base. The knowledge base was able to eliminate confusion, increase confidence and reduce uptake take
for first-time virtual reality users. Future work should include maintaining and updating the knowledge

base as required, thoroughly testing the efficacy of the complete guide, and adding interactive quizzes.
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Chapter 1 — Introduction
1.1 Virtual Reality

1.1.1  Introduction to Virtual Reality

A visual representation of the three dominant technologies that encompass the extended realities (XR)

is seen in Figure 1.
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Figure 1: Visualisation of XR Technologies [1]

Virtual reality (VR) is a computer-generated simulation which digitally controls the wearer’s visual and
auditory experience. The user interacts in the digital environment with the possibility of some sense of
touch [1]. VR simulations allow for interactive manipulations of models to aid in acquiring knowledge

and practical skill in a safe environment that delivers a vivid and immersive experience [2].

VR has seen early acceptance and adoption from the video gaming community. The complete
immersion works to enhance the game experience, making it more realistic and interactive. Headsets
have become more commercially available and affordable as the technology has improved. Further, the

uses of headsets and available applications have expanded, given the increased uptake of the devices.

In comparison to other XR technologies, VR provides an entirely immersive experience as users wear
a head mounted display. VR also produces the widest field of view and has the highest quality image

and colour representation [3].

UNSW currently owns several Oculus Quest 2 VR headsets [4], often rated the best VR headset on the
market. The rating is a result of the native hand tracking feature. Therefore, they will likely be the
headset used in this project. Oculus Rift, HTC Vive, and Valve Index are all popular VR headset models
on the market. HP states that its 2020 Reverb VR Headset is the “new benchmark in Commercial VR”

[5].
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1.1.2  Virtual Reality in the Medical Field

In the medical realm, the use of VR technology dates back at least to the 1990s [6]. The tool is currently
used for stroke rehabilitation, pain management, and exposure therapy [1]. VR has also been found to
be highly useful in surgical education and planning. This is a consequence of the repeatability of the
simulations to help build muscle memory, and the total immersion means that the simulations can occur

anywhere and anytime.

Developing VR simulations is particularly helpful to train surgeons with complicated surgical
techniques in a safe environment, leading to better outcomes for surgeons and patients. An example of
such surgery is catheter and cryoballoon ablation used to treat atrial fibrillation (AF) patients. AF is the
most common sustained heart arrhythmia, causing the heart to beat irregularly and chaotically [7, 8].
AF is a significant health challenge, particularly for developed nations, and its prevalence is on the rise.

6-12 million people are expected to develop AF by 2050 [9].

1.2 Learning Virtual Reality

Understanding game development is critical to advance VR use in all settings, including within the
medical field. However, with no prior game development experience, it is time-consuming and
confusing to learn. A simple Google search of “How to make Virtual Reality Games” gives rise to about
303 million results. Consequently, without a structured guide, it is almost impossible to know where to
start, which may be off putting and prevent many people from discovering the possibilities of VR and
game development. Game development is game construction, whether that be in 2D or 3D for virtual

reality.

1.3 Thesis Aims

This thesis project aims to build a guided knowledge base (KB) for people wanting an introduction to
VR and game development to reduce the confusion, initial learning curve, and any time-wasting

activities that would arise when learning independently.

The KB will have additional resources for students working in the medical field, for example when
working towards building ablation surgery simulations. In turn, users will spend less time upskilling
and more time developing simulations for the virtual world, which will be particularly beneficial for

students on projects with a set time frame.
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Chapter 2 — Literature Review
2.1 Use of XR Technology in the Medical Profession

2.1.1  Surgical Training and Education

Simulation teaching has risen in necessity as the clinical duty hours of trainees and experts have been
reduced to prevent fatigue [10]. Simulation teaching is defined as “a technique to replace or amplify
real experiences with guided experiences that evoke or replicate substantial aspects of the real world in
a fully interactive manner” [11]. XR has become an established practice for medical students to gain
and retain anatomical and surgical knowledge and skill. The use of XR for surgical training also
eliminates ethical problems, such as the use of cadavers and improves patient safety. A 2021 French
review of simulation teaching in cardiology highlighted that simulation training can aid in the transfer
of learning and should be embraced to master complicated techniques and to gain experience in high-

pressure crisis scenarios [10].

Many studies [1, 6, 12-15] have demonstrated the usefulness of simulation in healthcare education and
training. These studies have proven that there is a significant correlation between surgical performance
in simulations and operating rooms and the effectiveness of simulation in retaining knowledge and
acquiring technical skills. Studies have also proven that trainees who use VR simulation in their
curriculum are quicker to complete their learning tasks than peers who did not use VR [6, 10]. However,
more research needs to be performed to validate the transfer of technical skills from simulation to open

surgery and evaluate the impact on clinical outcomes [15].

A 2021 review of medical simulation techniques found that 78 per cent of simulations were custom-
built and required custom hardware or props [16]. Though this means the simulations can be specifically
tailored to the study’s needs, the simulation is therefore not commercially available for medicine fellows
to utilise. This review however, primarily focused on using AR or MR. By incorporating aspects of the
real world into a digital space and utilising VR technology, the system can be simplified and eliminate

the need for expensive specialised equipment.

One such study [17] used AR for the visualisation of tubular structures, in addition to physical
stimulation, to reproduce realistic surgical scenarios, such as the interactions between surgical
instruments and anatomy. This simulation aided medical students' practical skills and complements
simulations that focus on students' knowledge of anatomy and medical procedures. For example, a VR
experience was designed to improve students’ learning in AF to educate patients effectively [8]. The
simulation was a 320 second narrated overview of the AF ablation procedure, which consequently

improved confidence and knowledge scores.
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2.1.2  Preoperative Planning

Preoperative planning is an essential decision-making process for surgeons, as it requires consideration
of the desired result and the surgical tactics and logistics to achieve it [18]. This can be made difficult
when attempting to gain a complete perspective of complex procedures from traditional 2D screens.
Therefore, XR technology has been advanced to view patient-specific information in a 3D interactive

format. Consequently, surgeons can make better, safer, and more informed decisions for their patients.

For surgeons, visualising and manipulating personalised 3D models in VR enhances their understanding
of the patient’s condition, as in Figure 2. The IMHOTEP framework took patients CT and MRI scans
and transformed them into 3D models, which were then available to view and interact within the VR
space [19]. This advanced visualisation allowed surgeons to better consider the patient’s anatomical
situation before commencing the surgical operation, leading to greater precision and more informed

decisions and better outcomes.

Figure 2: Explore Heart Anatomy using VR [20]

The FaMaS-VR user interface evolved from the IMHOTEP progress to enhance the interaction between
the surgeons and the 3D VR models, specifically for the treatment of heart arrhythmias such as AF. The
FaMaS-VR tool enabled surgeons to test various placement options for ablation lesions in real-time.
This provided a safe and ethical method for surgeons to consider, plan and determine the most
appropriate ablation strategy. The program was deemed intuitive by more than 95 per cent of tested

students and researchers [8].

There have been several tools that have utilised patient images to create 3D VR images and assist
surgeons in planning procedures. The MedicalVR platform utilised DICOM images specifically for
cardiac surgeries. However, unlike most other studies, this technology was used successfully in clinical
practices, aiding in the preoperative planning of cardiothoracic surgeries. The surgeons were
particularly interested in the technology to view the patient’s anatomical structures to determine the

ideal location for surgical access [21, 22].
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VR is the most appropriate technology for preoperative planning as it creates complete immersion and
higher resolution of images in comparison to other XR technologies. This is important as the technology

becomes used in clinical practice to provide greater precision and further assist surgical planning.

2.1.3  Open Surgery

AR and MR technology is more suitable and reliable than VR to implement intraoperatively, as users
can communicate with their team and be aware of the physical environment. There are two dominant

uses of XR in live surgeries that have been tested.

Firstly, AR technology uses 3D models generated before surgery, from CT or MRI scans, and
superimposed on the surgeon’s field of view. This provides surgeons with better spatial visualisation
and improved safety for patients [23]. During pancreatic surgery, this has been used to identify lesions
and make safer dissections to preserve adjacent vessels or organs [24]. However, further advancements
in live organ tracking to overcome organ shift and deformation post-puncture issues are essential before

this technology can become the norm in clinical practice [25].

The second use of XR technologies intraoperatively is to display 3D information in real-time,
traditionally viewed on 2D monitors. Surgeons used MR headsets to view real-time 3D data obtained
using Electroanatomic Mapping Systems and 3D transoesophageal echocardiography during live

electrophysiology procedures and structural percutaneous cardiac interventions [3, 26].

AR and MR technology is the future of surgical procedures increasing precision, speed, and patient
safety. However, this technology requires development to improve display quality, alignment errors,

and ergonomics for more intuitive use.

2.1.4  Limitations in the use of VR and AR

Despite the recent exponential improvement in XR technologies and usage in the medical field, there
are still limitations preventing the technology from surpassing current practises. These include initial
setup costs, which was listed in a study of general surgical residents and experts as the primary barrier
to its uptake [27]. Headsets can cost as much as $1399USD, and sufficiently powered computers can
cost upwards of $2100USD [28]. Furthermore, multiples of equipment need to be purchased to allow
for simultaneous users. Additional costs include accessories, such as hand controllers, the costs for the
programs and necessary licensing to be loaded onto the devices, and the ongoing cost of repairs and

upgrades [10].
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In current commercially available technology, compromises are made between cost, usability, and
quality [1]. Often inexpensive VR headsets lack the high quality, detailed display required for effective
simulation. Tethered headsets restrict movability and often add to the headset’s weight and size.
Untethered headsets allow free movement but entail shorter usage times and have a reduced field of
view. As technology improves, these compromises will be reduced. The current rapid rate of technology
improvement in the extended realities however creates uncertainty when trying to justify substantial

financial investments that could become outdated within a matter of years.

If an appropriate headset and necessary funding can be found, there can still be ergonomic problems in
using these devices. In a study involving 170 participants using the Microsoft HoloLens, 26 students

suffered headaches, and 17 felt nauseous and experienced eye fatigue or neck strain [29].

Implementing innovative technology introduces a learning curve for all, and considerable time may be
required for teaching staff to learn how to use, assist, and assess students in the virtual world. Not only
does this take time away from medical experts working in their field, but it may require further costs
for training packs and user demonstrations. The success of the student’s learning in the simulated

environment is almost entirely dependent on the teacher's medical and technical expertise [10, 21].

Unfortunately, there are still limitations in the current technology, restricting the immersive nature and
accuracy of the simulated environment. The lack of haptic feedback (the expected sense of touch) is
one of the drawbacks when interacting with objects in the digital world [1, 10]. Haptic cues allow for
greater immersion and a sense of presence in the virtual world [30]. This is emphasised by a study [31]
which ascertained that surgical simulations require haptic feedback to provide a complete experience
for trainees. Furthermore, the feel of using standard hand controllers, such as the Oculus Quest 2 hand
controllers in Figure 3, compared to medical-grade tools, reduces the simulation's realism. A concern
is that the transfer of skills from simulation to live surgery may diminish with the different hand

positions with the controllers and the lack of tactile feedback [32].

Figure 3: Oculus Quest 2 Controllers [33]
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Another option to create a more natural hand position would be to implement the use of VR haptic
feedback gloves, such as the Haptx Gloves DK2 (AxonVR LLC, Seattle, United States) or the Dexmo
Force Feedback Gloves (Dexta Robotics, Shenzhen, China), both seen in Figure 4. These gloves both
feature an exoskeleton design that allows hand movement and can physically displace the users’ hands
as would an object. However, this would be an additional expense, requiring upkeep and upgrades. The
most viable and accessible VR simulation should use as few accessories as possible, which will

minimise cost, maintenance, and complexity, and reduce need for retraining.

Figure 4: Haptic Feedback Gloves - Haptx DK2 [34] (left) and Dexmo [35] (right)

Finally, tracking and alignment errors occur when attempting to place digital images in the real world.
This is a critical issue that restricts the use of XR in live surgeries, as there are problems both in the
alignment of an image onto the human body and the tracking of hands or controllers in the physical
space [3]. Tracking of controller movement can be achieved to the necessary accuracy with instruments
such as NDI’s Aurora [36]. However, this comes at a high cost and requires supporting equipment. Live
tracking of a patient’s physical positioning is more challenging to achieve. A study [25] showed that
accuracy could be achieved in the virtual world with a 2.5mm error. This translated to an error of 12 -
17mm in the physical world. Another study [17] reduced errors to a mean of 0.35mm, with a maximum
error of 0.99mm. Both margins of error are deemed unacceptable in clinical application, but it is
interesting to note that most of the error occurred in the z-axis. This suggests that errors occurred by the
operator pushing down and deforming the target area. Live organ tracking could be implemented to
negate the body’s deformation; however, this area requires further development to be suitable for use

[37].
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AR provides the ability to stay present and communicate in the physical world and is far more suitable
for open surgery. However, presently VR technology is surpassing AR and MR in terms of quality and
detail of image produced. AR also restricts the users’ field of view and does not provide the immersive
and realistic experience of VR. Though the immersion into the digital world is unsuitable for operating
room procedures, VR models are more accurate and reliable and prove highly useful for simulating

surgery for training purposes.

2.2 Learning Virtual Reality

2.2.1 Learning Game Development for Virtual Reality

The issues limiting the use of XR technology in medicine are also preventing their use in schools and
universities. Primarily this is the high setup costs for equipment, accessories, and upkeep [10, 27], as

well as the rapid pace at which the headsets and accompanying software are updating.

Currently, options to learn game development in a structured course are very difficult to locate. Some
institutions, such as SAE Creative Media Institute, offer formal courses on game development. This is
not however an individual course to introduce game development, but a complete university level,
multi-year, expensive program leading to degrees [38]. Therefore this is inaccessible to most who are
not specifically aiming for a career in game development. Consequently, most students have not been

taught game development.

In creating a university elective course on game design and development, trial and error were able to

map a path to successfully teach game development without prior experience [39].

The first decision was which game engine should be used. A game development engine increases the
efficiency and simplicity of game building “by handling complex computations such as object physics,
3D primitive shape creation, animation, sound, collision detection, and trigger events” [40]. When

deciding which engine to use, a seven-step guide has been created [41]:

1. It must be easy to learn

It must be popular to attract student interest and prevalent in industry use cases
It must support programming languages with which students are familiar

It must allow development under both Windows and macOS

It must have a stable implementation

It must have sufficient documentation and a strong online community for support

N AN

It must be inexpensive to acquire and use
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Table 1 nominates various game engines and compares their available languages, what computer

system/s they work with, their approximate community size, and price.

Table 1: Various Game Development Engines and how they fit the criteria for use [40]

I_ GE Available Programming Languages Dev OS Help Community Price |

Blender Python macOS, Windows, Linux Large Free

CryEngine C++, Flash, ActionScript, Lua Windows Medium Subscription

Frostbite C++ Windows Medium Proprietary
Lumberyard C++, Lua Windows Small free
Source 2 C++ Windows Medium Free
Torque3D C++, TorqueScript macOS, Windows, Linux Large Free
Unity C#, JavaSeript, Boo macOS, Windows Large Free
Unreal C++, Blueprint macOS, Windows, Linux Large Free

After analysing all available options and removing those without VR capabilities, Unity was selected
as the game engine of choice. It most comfortably meets all the given criteria. It was noted to have the
shallowest learning curve. It is free for educational purposes and accessible cross-platform [39]. More
recently, Unity has pulled ahead as the go-to platform for game development. In fact, “as of September
2019, 52% of'the top 1,000 mobile games were powered by Unity, as well as 60% of all AR/VR content”
[42]. Furthermore, it supports all virtual reality headsets, which eliminates any issues if a headset
manufacturer changes. Consequently, Unity skills and knowledge is valuable in the gaming industry,

where the game engine has become prevalent.

Unity has published a comprehensive set of learning courses for all skill set levels, called Unity Learn
[43] to help users learn the platform. Additionally, there is a thriving online community of Unity users

which can be found on blogs offering support and answering questions.

Following the decision to use Unity as a game engine, there comes the decision of how to effectively
and efficiently teach students how to use it, so they are able to spend more time on game development.
In this instance [39], a textbook was followed, but once the course was implemented, the book was out-
of-date, and therefore online sources were required to complement the resource. Each week, students
would complete a chapter of the text and recreate the example built as a lab assessment. This forced
students to continually make progress in learning Unity, and at the end of the course, all groups were

able to build a playable game.

Though this method was successful, the paper was written in 2015. Even then, the most significant area
of concern was “the rapid development of Unity and the effect this has on finding up-to-date materials
to work with” [39]. Since then, Unity has grown exponentially and has outpaced authors. However, the
method of continuous and gradual improvement through example recreation is still relevant and

practical.
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2.2.2  Effective Methods for Distance Digital Learning

A Knowledge Base (KB) collates resources and information about a topic, presented in a self-serve
format [44]. This KB must assume users have no experience as is the case for most students without

courses in schools or universities.

The self-serve format allows students the freedom to choose how and when they study. It has been
proven an effective study method, but only when appropriate strategies are used. Students must choose
to spend more time on complex problems. Significant issues however arise out of the accuracy of
memory monitoring. Students may have biases and inaccuracies in their understanding and
comprehension of the topic. For example, “poor students overestimate performance by up to an

astonishing 30% of their actual test score” [45].

In addition, students tend to spend more time on areas they enjoy and may actively avoid topics they
deem more difficult. Consequently, students can make counterproductive decisions regarding time
spent on a subject [45]. Introducing recommended timeframes to spend on each step of the KB will help

reduce students’ biases and create better learning outcomes.

One problem that may arise from having a singular resource format is that it does not cater to a diversity
of students and their varying study preferences, often divided into learning styles. Learning styles can
be defined as preferences in the learning situation, or the approach students generally gravitate towards
when acquiring a new skill or piece of information [46]. Though there is a myriad of learning categories,

the three most used are pictured below in Figure 5 and can be defined as:

e Auditory Learners: These learners interpret information through auditory cues such as pitch,
emphasis, and speed and learn through listening.

e Visual Learners: This is the most common of the presented learning types. These learners tend
to think in images and learn best through pictures.

o Kinaesthetic Learner: These learners work best when interacting with the physical world, often

through demonstration and replication of actions. °

§ ® @

AUDITORY VISUAL KINESTHETIC

Figure 5: Learning Styles [47]
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A KB would need to incorporate all three learning styles to be accessible and effective for all students.

Finally, an effective KB designed for self-paced learning needs to look towards the lessons learnt during
the COVID-19 pandemic in terms of distance learning. Distance learning occurs when students and

teachers are separated by space and possibly time and utilises a broad spectrum of technologies [48].

Current students have now been exposed to at-home learning more than any other generation has before
them and know how best they learn away from the classroom setting. Various pieces of literature [49,
50], include three suggestions to incorporate into distance learning to increase student engagement and

SUCCEsS.

1. The source of information must be intuitive, user friendly, and well maintained. Students will
become uninterested when the resource is too hard to use, as more time will be spent trying to
understand the source rather than learning the content.

2. There needs to be some form of interaction with the material. Whether that be a follow-along
tutorial where students can create something, a quiz, or group work. Without these elements,
students tend to absorb information passively, and therefore nothing will be retained.

3. Students need someone they can comfortably talk to when they have questions. Many
knowledge bases utilise a chatbot. However, a supervisor they can quickly communicate to is

equally or more effective.

The key takeaway is that to create an effective learning tool that teaches VR game development, content
needs to be designed explicitly for the environment in which it is taught. In this instance, the content
will be presented as an asynchronous, distance learning program. To keep students engaged and
interested in the topic, the tool must be intuitive, interactive, and accommodate diverse students’

learning preferences and styles.

2.3 Future Direction of XR in Medicine

The role of the XR in medical practice will develop as the technology improves and becomes more
accessible and ergonomic. With more access, more minds can consider newer and more incredible ways

to utilise the technology as its performance and reliability improve.

Research needs to be performed to clarify and validate the ability of trainees to retain skills from VR
training, as more authentic simulations and haptic capability are introduced. Simulations should be
developed to address more complex cardiac procedures and promoted by establishing a training

curriculum [10, 12].
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Based on the current commercially accessible technology, it seems best to explore VR as it is more
advanced, provides more detail, and creates the most realistic simulations. Introducing hand tracking to
medical simulations has the potential to progress the virtual world experience further. The realism of
the simulation may be further enhanced by adding basic props in the physical world that align with
rendered objects in the digital world [21, 51]. This will provide haptic feedback to enhance the user’s

presence in the simulation.

To truly create realistic medical simulations, access to patient data would be required. Live positioning
data could be used cohesively with VR technologies to enhance user experience with better visuals and

real-world accuracy.

Students however need to learn how to develop games for VR applications. Without easily accessible
game development courses, students will waste valuable project time on upskilling rather than building
meaningful simulations. Therefore, it has been determined that a resource to teach VR game
development is necessary. Future students will benefit from previous work by creating a resource that
students can refer to and then update as they make their game development advancements. This will

lead to faster progression of VR projects as they are handed off to new students in the long term.
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Chapter 3 — Methodology

3.1 Overview

The primary objective is to build a guided KB to effectively learn VR game development to reduce the
time it takes to upskill. Users of the KB could include novices to VR and game development. There is
also a focus on students wanting to learn VR to develop simulations in the medical field. Therefore, the
tool must explain the entire process of using the VR headset for the first time, connecting it to a
computer, downloading relevant software, and using Unity for game development. Figure 6 illustrates
a high-level overview of the process followed to create the KB, working from top to bottom.

( \
 Learnand Upskill 1

[ on Unity |
N e e - - - ! Create survey to find
l what students want in a
self-directed study tool

Determine the
necessary base

skills required to
Use survey results to

A —

use Unity . .
________ determine best tutorial
resources and format
T \
" Find resources for the |
, required skillsinthe
| desired format |
_____ ]_ PR —
l( Create the knowledge :
N base (KB) )
Test the KB Review and adjust KB

Figure 6: Methodology Overview Flowchart

3.2 Determine relevant Unity skills

3.2.1 Learn and Upskill on Unity

The first step was to learn how to use Unity and understand which tutorials effectively teach the game
engine. Therefore, textbooks, online tutorials, blogs, and Unity Learn were all utilised and ranked in

terms of efficacy in teaching.
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To evaluate the effectiveness of each tutorial format, the tutorial should be replicated 24 to 48 hours
after the initial learning without the tutorial in hand. This tested memory retention and the fundamental
understanding of the Unity skill/s that should have been communicated in the tutorial learnt. For
example, the steps may not have been completed in the perfect order. Still, if a decent replication of the

original content were achieved, the tutorial would have effectively taught the skill.

3.2.2  Determining the required skills for the knowledge base

At this stage of the process, all skills required for basic game development should have been learnt. It
was found that from upskilling, and experience from Joshua Dawson (another thesis student who also
used the Unity game engine for the first time) the necessary skills to successfully develop games will
be determined. It is essential to differentiate the steps relevant only to Joshua’s thesis from critical steps
for all game developers. Additionally, there should be content around setting up any required software

and guide any use of hardware.

33 Survey for Knowledge Base Formatting

Though the personal experience was critical when determining what tutorials are most useful for VR
game development, it was essential to eliminate biases. Therefore, a survey was created to discover
what students who have experienced distance learning find the most useful for their education. The
objective of this part of the survey would be to determine the best content type for the KB, whether that

be a video tutorial, textbook, or something entirely different.

The secondary objective of the survey would be to find students’ preferred format for the KB. That is,
how the KB resource itself is presented. The options were either a PowerPoint presentation, Word

Document, or a specially designed website.

The survey must be easy and quick to complete to ensure responders answer all questions appropriately.

34 Creating, Testing, and Finalising the Knowledge Base

3.4.1 Creating the first draft Knowledge Base

Following the survey and upskilling on Unity, the project's next stage is to build the KB. The learnings
taken from the survey clarified that YouTube tutorials are a preferred mode of study and that the KB

will be made on PowerPoint.
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The first step in building the KB was to define all the steps. Each step was given one slide, with the

ability to link additional material to other slides.

Once a general plan of all the steps was made, the content needed to be inserted. There was an attempt
to find a video demonstration for most actions as this was the preferred learning method. Between the
survey results, personal experience learning game development, and literature, tutorials used in the KB

must meet the following criteria.

Be a follow-along, step-by-step demonstration.

Have at least a transcript or the steps written out.

Have been created in 2021.

Be able to stand on its own as a tutorial, i.e., it does not require watching previous tutorials.
Have an engaging presenter with an understandable accent and who speaks at an easy cadence.
Not exceed 35 minutes.

Not double-up on content previously learnt.

N N N N N W RN

Be relevant and have a known purpose towards developing Unity skills.

Following that, each Unity tutorial needed to be revamped with the latest installation of Unity. Whilst
completing the tutorials, timestamps were taken of any step that was not entirely obvious or may have
slightly changed following an update, from the video demonstration or the accompanying narration.
Next, a better and more explicit explanation of that step needs to be added to the tutorial slide with the

timestamp.

For some of the setup process, there was no video demonstration. Therefore, straightforward steps with

screenshots of relevant instructions were attached.

Anything additional to the core step, such as troubleshooting methods, was also linked to a separate

slide in the presentation.

Finally, once all the content has been added, it is essential to ensure uniform and clean formatting. Users
do not want to be distracted by many graphics and instead want to visualise the content easily.
Additionally, a progress bar and “Mark Step as Complete” button should be added to match the Unity

Learn tool. Any links, particularly external links to videos, should be obvious to use.
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3.4.2 Testing the Knowledge Base

The knowledge base must then be tested on people with a range of Unity and VR skillsets. Users will

be given the KB without instruction and report back on their experience using the KB.

Users without Unity experience should then be quizzed on how helpful the KB was. Some questions

that could be posed include:

1. How intuitive was the KB to use?
2. How confident do you now feel in your skillset developing games in Unity?
3. If you were challenged to replicate the project/s made throughout the tutorials, would you be

able to do it?
On the other hand, users with Unity experience should be asked a different set of questions.

1. How intuitive was the KB to use?
What method did you use to learn Unity game development?

Was using the KB easier than the method you used, and which method do you prefer?

v

Are there Unity game development skills you believe are necessary to learn that are not

available in the KB?

The first section of the KB is dedicated to brand new users of VR headsets. This should guide users
through the initial setup phase to correctly connect the headset to their computer. It should also guide

users through their first experience in VR. Users of the KB should also additionally be asked:

1. Did the KB help you during your first use of the VR headset?

2. Is there additional information you feel should be provided to first time VR users?

3.4.3  Refining and Finalising the Knowledge Base

Feedback from testing will contribute towards refining the KB. The KB also needs to be maintained

and monitored, as any update to Unity may result in slight changes to the user experience.

Following each update of the KB, it should be re-tested on a new set of users. Similar questions should

be asked, and the process of refining should continue.

Once new users are entirely confident in the Unity skills following using the KB, and experienced Unity
users feel that the tutorials are comprehensive enough as an introductory tool, the KB can be finalised
and published.

If significant upgrades to the Unity package occurs, the KB may need to be adjusted to fit. Minor

changes, such as bug fixes, should not cause too many headaches for users.
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4.1

Chapter 4 — Results

Finalised Knowledge Base

The finalised KB is a 35 slide PowerPoint, shown in Appendix A — Completed Knowledge Base Slides.

A summary of the slides is presented in Table 2. This KB eliminates confusion for students learning

VR game development for the first time. It walks students through their first use of a VR headset,

installing the necessary software, and taking the guesswork out of finding helpful, relevant, and up-to-

date tutorials to demonstrate game development.

Table 2: Outline of KB Slides

Section Title: Title Slides
# | Slide title # | Slide Title
1 | Title Slide (VR Knowledge Base) 2 | Table of Contents
Section Title: 01. Set Up Headset
3 | Section Contents 4 | Explore and Set Up your Headset
5 | Set Up Oculus App 6 | Using Oculus Link for Set Up
7 | Using ADB Drivers for Set Up Example Command Prompt (Windows)
9 | Connect Headset to computer 10 | OPTIONAL: Enable Wireless Connection
Section Title: 02. Unity Set Up
11 | Section Contents 12 | Download Unity Hub
13 | Install Unity Module
Section Title: 03. Unity Basics
14 | Section Contents 15 | Introduction to Unity and Navigation
16 | OPTIONAL: In-depth Unity Tutorial 17 | Create a Unity Scene
18 | Apply Hand Controllers 19 | VR Interactable Objects
Section Title: 04. Extra Unity Tutorials
20 | Section Contents 71 Calibration: Aligning the real and virtual
world
22 | Recreate an environment in VR 23 | User Interaction
24 | Hand Tracking 25 | Completed!
Miscellaneous Slides Linked Throughout Previous Slides/Steps

Troubleshooting Methods to Connect o
26 Headset with ADB Driver 27 | Calibration Method
28 | Calibration Code 29 | Install android winusb
30 Troubleshooting: Building and Running 31 Troubleshooting: Test in VR with Oculus

Unity Program through ADB Link
3 Trogblesk.lootm.g: Test Live with Laptop 33 | Updates on Setup

Device Simulation
34 | Tips to Reduce Blurriness 35 | Controller Explanation
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Each section features a Section Contents page, as seen in Figure 7. The purpose of this slide is to
establish the direction of the section. It allows students to have an idea of the content that is about to
come up. Furthermore, each sub-title, such as “Apply Hand Controllers”, is individually linked to the

respective slide to allow students to skip to the desired tutorial quickly.

03. Unity Basics

Set Up Headset
Unity Set Up

Unity Basics

Introduction to Unity and Navigation
OPTIONAL: In-depth Unity Tutorial
RECOMMENDED: Create a Unity Scene
Apply Hand Controllers

VR Interactable Objects

Extra Unity Tutorials

Get started >>

14

Figure 7: Section Contents Example Slide

Each tutorial slide page features a progress bar of the stage, as seen on the left of Figure 8. Once the
user clicks the “Mark Step as Complete” button in green on the bottom right, the slide will move to the
next stage of learning. The orange circle on the progress bar, which indicates the current step in the

section, will then turn green. The blue circle marks the number of steps to come.

Create a Unity Scene

Click here for a tutorial that explores all the basic fundamentals of building a game in
Unity, including packages to download and all set up requirements

Notes on some updates since tutorial was made:
1. Click here to view the changes in set up since the tutorial

2. When setting up the XR Rig (Action-based), select XR Rig, and then in the inspector change the
Tracking Origin Mode to “Floor”

3. Click one of the Links below for different methods to Build and Run the program

Troubleshooting Methods for Building Test in VR with Test on other Test Live on Laptop
and Running Program through ADB Oculus Link OpenXR Devices Device Simulation

Note: whilst in the game play around with basic objects using the toolbar
(pictured) at the top left corner of the Unity editor to explore useful features
such as the Scale, Move, and Rotation features : :

Mark Step as Complete

17

Figure 8: Tutorial Slide Example Page
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There are two links in the slide featured in Figure 8 that users can click on to access. Using a blue,

underlined font and the words “Click here” means users instantly know to click on the link.

The first link takes the user to the YouTube tutorial. The tutorial could have been inserted onto the slide;
however, navigating outside the resource to the web page will allow the user to simultaneously have
the tutorial and the PowerPoint ready to use and reference. Therefore, students can see the notes as they
go through the tutorial. This necessity is more apparent in Figure 9, where the notes are presented with

timestamps for reference throughout the tutorial.

VR Interactable Objects

Click here for tutorial about creating and interacting with VR objects

This is a continuation of the previous tutorial so can skip setup and use
previous project

Notes with timestamps:

* 4:30: To select material colour, select the white square across from Albedo
* 5:30: Click here for link to asset used

P * 5:50: To find the Asset List navigate through Window > Package Manager and switch
L 4 from ‘Unity Registry’ to ‘My Assets’ at the top of the tab

* If the asset does not appear: ensure your Unity store and Unity Hub/Project is logged into the
same account

Once tutorial is complete, select Mark Step as Complete and return to

previous tutorial
Mark Step as Complete

19

Figure 9: Example Tutorial Slide with Timestamped Notes

The second link on Figure 8 takes the user to the miscellaneous slide, “Updates on Set Up”. This slide,
shown in Figure 10, breaks down changes in the Unity setup since the tutorial was published. Though

most of these changes may be intuitive, it was vital to eliminate all potential confusion.

Figure 10 differs from the tutorial slides as there is no progress bar, and the step completed button would

return the user to the Unity Tutorial in Figure 8.
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Updates on Set Up

Click here for tutorial demonstrating these steps:

When installing the package in XR Plug-In Management (Edit > Project Settings):

a)  Select OpenXR, rather than Oculus to accommodate all headsets

b)  Once OpenXR is selected there will be a warning. Click on the warning and select “Fix All”
c)  Oneissue should remain, so select “Edit”

d) Under Interaction Profiles select the “+” sign and select at least “Oculus Touch Controller Profile” (if you are
unsure what device will be used, also add “HTC Vive”, “Microsoft Motion” and “Valve Index”)

YWE

e)  Click the Android Tab at the top of the screen and repeat step C on this separate tab

f) Return to XR Plug-In Management and go to the Android Tab. Again select OpenXR, click on the issue that pops
up and select “Fix All”

g)  Exit settings and navigate: Window > Package Manager > OpenXR Plugin, click into Samples, and Import

Controller Samples
Return to Unity Tutorial

34

Figure 10: Example Miscellaneous Slide

Steps such as “Install Unity Module” shown in Figure 11 do not have an accompanying tutorial. Instead,

a relevant image of the action has been inserted.

Install Unity Module

Add Unity Version X

d. Press “ADD” in the top right corner of @& selectaversion of Unity © Add modules to your install
InSta"S page Add modules to Unity 2020.3.19f1 : total space available 45.9 GB - total space required 17.5 GB
e. Select the most updated LTS version of Platforms
Unity and ensure “Android Build Support” v B Android Build Support 371.2MB 1968
and all child modules are selected when B Ancroid SDK & NDK Tools — —
asked to add modules (in screenshot across) B omennx . 1530MB
f. Follow the prompts in Unity Hub to
continue downloading and installing, then (] 1osBuid support SE2I6INE Leic8
wait for it to install |:| tvOS Build Support 366.4 MB 1.6GB

D Linux Build Support (IL2CPP) 103.4 MB 433.9 MB

g. When on the Installs tab, the version
downloaded should have an Android icon. If CANCEL BACK NEXT

not, select the three dots, select “Add
Mark Step as Complete

Modules” and complete Step e
13

Figure 11: Tutorial Slide with Image
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4.2 Testing the Knowledge Base

The KB’s success will be determined by how significantly it reduces the learning curve for students
new to VR, no matter their confidence in using new technologies. Unfortunately, the KB could not be
entirely tested due to delayed completion and travel restrictions resulting from the COVID-19
pandemic. However, the first two sections of the KB, Set Up Headset and Unity Set Up, was tested on

four family members, all with no experience of VR and varying confidence using new technology.
The four test subjects were divided into two groups.

1. Group one comprised people more confident using technology, and, as they were younger (aged
19 and 20), they had a better instinct utilising the headset.
2. Group two’s members (aged 55 and 56) were significantly more hesitant to enter VR and

experienced more difficulty using technology.

The primary objective of the first tutorial slide, shown in Figure 12, was to prepare users for their first
experience using the VR headset. One member of each group was first encouraged to use the headsets
without consulting the KB. These two users will be referred to as the control users. They were given
the task of creating the guardian (the boundary a user can stay within when using the headset), changing
the volume on the headset, connecting to WiFi, and playing the “First Steps” game. The same tasks
were presented to the other group member, referred to as the experiment users. However, the experiment
users were given the KB before using VR. The experience of the two group members was compared to

understand the efficacy of the slide in Figure 12.

@ Explore and Set Up your Headset

* Before trying on the headset for the first time:
* Make sure you sure you are in an area with lots of free space
* Ensure you have the correct controller in each hand, and secure the strap to your wrist

* Ensure your headset is charged using the USB-C charger (the power light should be
green)

¢ Click here for an introduction tutorial which will outline comfortably fitting the Oculus
headset, set up the guardian, maintenance and care, and navigation in VR
* Exploring the Headset
* Place the headset on and turn it on (Power button located next to light when charging)
* Explore the home page, find the settings (click here for explanation) to adjust the

* Click here for tips to reduce blurriness when using the headset
* Have fun, play some games, and try to get a natural feeling and
understanding of the headset

4

Figure 12: Knowledge Base Slide for First Time wearing VR Headset

21



Kate O’Sullivan

The Development of a Guided Knowledge Base to Effectively Teach Virtual Reality Programming

Each member of the trial had a unique experience using VR for the first time. The group one control
user was able to complete the tasks required. However, the user noted difficulty navigating to the
settings menu and expressed that it was not intuitive. In contrast, exploring the app page was casy.
Furthermore, once the settings were found, completing the tasks was quite simple. The user could set

up the guardian, but this was met with some confusion and took a couple of attempts.

In contrast, the experiment member of group one had no difficulties using the headset. They successfully
set up the guardian on the first attempt and quickly found the settings menu. They were able to complete

the required tasks much quicker than the control group counterpart.

Therefore, it could be concluded that using the KB resource for this small sample group eliminated any
initial confusion and hesitation. Thus, the learning curve was successfully decreased, as did the time it

took to become familiar with the headset.

This experience differed significantly from that seen in group two. Group two members were much

more visibly hesitant to put on the headset and expressed nervousness and uncertainty entering VR.

Group two’s control member was surprisingly efficient at working through the guardian setup. In
comparison to group one members, this user took more time to read all the instructions diligently. In

contrast, group one members tended to go in headfirst and learn on the fly.

The control user in group two was also able to find the settings with relative ease. However, they faced
a significant roadblock when attempting to navigate away from the settings into the apps. There were
two obvious reasons why this user struggled to find the app library to play the First Step game. Firstly,
when trying to select an option, they did not know what button to press. As a result, they tended to press
all buttons at once. When a user presses all buttons, there is no consistency in how the headset responds,
and the user becomes lost within the menus. This prompted the inclusion of a new slide, Figure 13,

which visualises the Oculus buttons and describes the functionality of the two most used controls.

e The Oculus button: used to navigate in and out of apps and to pull up the universal menu
o The right-hand trigger button: used in the same manner as a left click on a computer. This button

is used to select options on the screen.

Secondly, the user did not know how to find the app library, as there is no obvious path from the
universal homepage. The user focused on trying the get out of the settings and then spent time on the
explore page. There is an option to select Apps on the bottom pane of the menu; however, the user had

difficulty finding this.
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Controller Explanation

8. Teleport

* Use the 7. Oculus menu
button on the right hand
controller to pull up the
universal menu to navigate
to settings, change apps etc.

* The Oculus button can also
be used to exit an app

* Button 5. Select Node is also
known as the trigger button
and used to click/select
options

3.Scale network

4.Translate network

Return to Headset Set Up

36

Figure 13: Knowledge Base Slide Highlighting Controller Function

Both issues were addressed in the tutorial linked in Figure 12. Therefore, it was interesting to observe
the different experiences from the experiment member of group two. The user expressed that setting up
the guardian seemed relatively easy, as they had seen the steps prior in the tutorial. They also knew to
use the trigger button alone as the select button and use the Oculus button to navigate in and out of

games. The tutorials also explained how to get into the Apps, so finding the App library was simplified.

One issue that group two members noted was blurriness. From that feedback, an additional slide was

added to the miscellaneous section, seen in Figure 14.

Tips to Reduce Blurriness

* Click here for a tutorial to adjust the headset if you are a glasses wearer
* Adjust the headset to change the eye level

* Adjust the distance between lenses

* For Oculus Quest there is a slider on the botton left that will adjust the lenses
distance

* For other headset a quick Google search should teach you how to adjust this

* Ensure you are wearing your glasses or contacts (preferable) if your eye
sight is poor

* Clean the lenses with an appropriate glasses cleaner (e.g. microfibre

cloth)

35

Figure 14: Knowledge Base Slide with Tips to Reduce Blurriness
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All four users were then asked to complete the first two sections of the tutorial, which involved
connecting the headset to a computer and downloading Unity. There was no control or experiment case,

and instead all users followed the KB.

Group one members both efficiently completed the tutorial steps and stated that the steps were easy to
follow. They both also expressed that navigation through the knowledge base was straightforward and

enjoyed marking a step complete and seeing their progress throughout the section.

Both group two members noted some confusion on finding options on the screen. For example, ‘press
the settings icon’ was not an understood term. Consequently, the slide was adjusted, and pictures were
added with cues to aid the process, as in Figure 15. Firstly, the content was split across two slides so
the font could still be legible, whilst the image was large enough to distinguish detail. Then the cues
were updated. ‘Press the settings icon’ then became ‘Press Settings (circled in blue)’, which matched
the accompanying screenshot of the Unity Hub homepage where the settings icon is circled with blue
ink. The profile icon was circled in red for navigation, and the Installs link is highlighted in yellow.
This adjustment particularly helped the group two members, as it removed the technical jargon that is
not accessible to all people. Furthermore, it added a visual element to the instructions, which further

helps comprehension for more students.

Download Unity Hub

" Click here for Video Demonstration of
1. Download Unity Hub the entire Unity Installation Process
2.  Once downloaded, open the

Unity Hub and complete any set
up procedure

a. Pressthe Icon in the top right ety il [O)C)
corner (circled in red) |lo e Projects -
b. Sign In/Up to Unity = e i, Tl i €]

c.  Press Settings (circled in :
blue) >> Licence
Management >> Active New
License

3. Press “Installs” on the left hand
column (highlighted yellow)

Mark Step as Complete

12

Figure 15: Knowledge Base Slide with Visual Guide
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The KB was also given to the UNSW Immersive Technology team. They all described the KB as
extensive and comprehensive. One interesting note they mentioned was to include a statement of ‘why’
to explain what the steps would achieve wherever possible. Though the ‘why’ statement is evident on
the tutorial slides, it was not the case for other slides, particularly the setup slides. For example, in

Figure 16, the first italicised paragraph was inserted to give users an understanding of the outcome of

the step.

Using ADB Drivers for Set Up

Android Debug Bridge (ADB) is used to communicate between your
computer and an android device, such as a headset, for debugging. ADB
is the software which lets PCs transfer and install apps onto Android-
based devices like Oculus standalone headsets .

* Download the Oculus Go ADB Drivers and ensure if is saved in a
known location:
o Windows
o Mac
o Linux

o

7

Figure 16: Knowledge Base Slide with 'why' statement
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Chapter 5 — Discussion and Future Work

5.1 Knowledge Base Formatting Decision Process

Whilst learning the Unity game engine, a survey was created to eliminate biases that could have affected
decision making regarding the types of tutorials and the format of the KB. There were 40 responders to

the survey, 37 of which had experience with distance education.
The results of the three key questions are shown in Figure 17.

Firstly, responders’ preferred format for distance education was PowerPoint. Alternate options
considered was a specific website or a Word document. The question specified that users should select
the best option for online learning and the easiest to use. This finalised the choice to use PowerPoint
for the KB. PowerPoint is accessible on all computers and free for UNSW students. PowerPoint can
also be distributed so that the file owner can continually update and maintain the content, but the user

1s unable to edit the file.

Two questions were asked to find students' preferred learning method, determining the tutorial type.
Video tutorials with follow-along instructions were preferred, and therefore, YouTube tutorials were

correctly chosen to be the dominant tutorial format.

The secondary preferred learning method was very close between step-by-step written and visual
instructions. The video tutorials and slides such as Figure 11, Figure 13, and Figure 15 should satisfy
those wanting visual education. Written instruction is present in the form of timestamps and the setup
process. The YouTube tutorials all have transcripts that can be used for those that benefit from written

instruction.

Another interesting question that was posed to responders is in Figure 18. Survey responders were
asked whether they preferred PowerPoint presentations with more slides with less text on each or
presentations with fewer slides with more text on each. Overwhelmingly responders preferred more
slides with less text. This feedback was applied to the KB in instances such as Figure 8. The row of
orange boxes is linked to separate slides in the PowerPoint pack. Therefore, reducing the word count

on the individual slide but increasing the total number of slides.
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What is your preferred platform for online learning i.e. which platform do you find easiest to
use?

40 responses

@ Website
@ Powerpoint
@ Word Document / PDF

What is your preferred learning method?

40 responses

@ Video tutorials with follow-along
instruction

@ Textbooks
@ Step-by-step written instructions
@ Step-by-step visual/pictured instructions

What is your second preferred learning method?

40 responses

@ Video tutorials with follow-along
instruction

@ Texibooks
@ Step-by-step written instructions
@ Step-by-step visual/pictured instructions

125%

Figure 17: Survey Results

When using a Powerpoint for learning which do you prefer?

40 responses

@ More slides with less text on each
@ Less slides with more text on each

Figure 18: Preferred formatting on PowerPoint
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The final question asked on the survey was: What makes an online learning platform effective and
creates the most memory retention? This was an open-ended question where responders could insert

their answers. All responses can be viewed in Appendix B. The most common theme of responses was:

e Examples and demonstration
e C(lear content

e Enjoyment of subject

e Quizzes

e Engaging lecturer

Examples and demonstrations, clear content, and an engaging lecturer are all used in the careful
selection of YouTube tutorials. Enjoyment of content can certainly be encouraged by providing
purpose, rewarding progress, and including stimulating demonstrations. However, the enjoyment
mostly comes from self-interest, something which students who want to learn VR should already have

before starting the KB.

Quizzes are the only element not currently in the KB. Quick questions after each tutorial could be added
to ensure memory retention. Asking students to replicate the tutorial content can also be a form of

assessment. Either ways, this is something that could be applied to future work.

5.2 Experience of Upskilling on Unity Learn

5.2.1 Overview

Unity Learn [43] is the official resource generated by Unity to learn game development. As it is the
official learning tool and the first result on Google when “Unity Tutorial” is searched, it was the first

tutorial format tested, as it would be for most first-time Unity users.

5.2.2  Drawbacks of the Unity Learn Tool

A significant roadblock preventing learning game development is the acceleration of Unity’s software.
This exponential improvement of the game engine has even outpaced Unity’s learning tool. As of June
2021, when this step was being completed, the most up-to-date Unity Learn VR tutorial used the 2019
version of the game engine. Though the game engine version could still be used, it was not compatible
with any of the current additional packages that needed to be applied. Furthermore, it missed out on

Unity’s developments and improvements over the last two years.
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There was though still an attempt to use the 2019 tutorial with the latest version of the game engine.
Unfortunately, this was unsuccessful. It seems that between 2019 and 2020, Unity dramatically changed
the setup, layout, accessibility, and user interface of their game engine. Consequently, almost every step
presented in the tutorial was redundant. It involved research through blogs such as Reddit, comments
on the tutorial, and even YouTube tutorials to find the new 2021 process to achieve the same outcome.
This process was highly time-consuming and massively decreased motivation. Despite attempting to
push through, the Unity Learn tutorial could not be completed, as too many steps simply did not exist

anymore, and therefore it was impossible to replicate.

In September 2021, a new updated version of the Unity Learn Introduction to VR tutorial was published
[52]. Though this tutorial was more accessible to follow as the steps demonstrated were accurate to the
game engine available, a few problems prevented Unity Learn from being the primary resource used in

the KB.

Firstly, the entire tutorial was approximated at 30 hours to complete, assuming perfect conditions, such
as a newer computer device with no latency, instant comprehension of each step, and some assumed

Unity knowledge from a previous Unity Learn tutorial that took 12 hours to complete.

Secondly, the tutorial is defined as a series and runs like a waterfall, meaning that users cannot complete
a step in isolation. For example, to complete step 5, users must have previously completed steps 1 to 4.
This is an issue because the main objective of the KB is to teach the need-to-know fundamentals, and
the Unity Learn tool went into significant and too much depth. Consequently, the KB could not just
select the steps within the Unity Learn tool required for the KB, as all actions prior would have needed

to be done.

5.2.3  Useful aspects of the Unity Learn Tool

Despite the difficulty of the Unity Learn tutorial, much was learnt, as if was found that the format of

the tutorials was highly effective. The tutorials were successful as they provided:

1. An effective combination of video and written explanations

2. A comment tool that allowed users to ask questions that either Unity or other users could
answer

3. Each section of the tutorial started by explaining the purpose and finished with a recap

4. Users could mark steps as complete and could visualise their progress as they worked their
way through the tutorial

5. Each stage was broken up into smaller, quicker steps
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Each step of the Unity Learn tutorial was presented as a video demonstration, with a presenter going
through the steps on the screen. This is a highly effective tutorial method, as it incorporates desirable
strategies for visual, kinaesthetic, and auditory learners. Additionally, for students who have English as
a second language, it is often difficult to find translations for XR technology jargon as it is relatively
new. Therefore, demonstration may be the only way to communicate and understand these processes

effectively.

The video demonstration did have generated captions, but the written steps were more concise and
simplified. Therefore, when there was difficulty understanding what the presenter did at a particular

stage, you could read the transcript of the video and read the step written out.

Furthermore, each stage had a comment section that Unity did seem to respond to actively. If Unity
themselves did not answer, other members of the large Unity community were quick to offer support.
Having these discussions available to all public was highly beneficial and increased efficiency, as often

users tend to have the same problems.

The other aspect of the Unity Learn tutorials that was helpful was that the tutorials were effectively
bookended. This means that each section initially stated its purpose and the direction of work. The value
of learning that step was also outlined. The last step of each section was a recap and summarised what

had been discovered.

Knowing the end goal from the start helped create momentum and excitement to sustain interest.
Additionally, by understanding the value of Unity and the possibilities that can come from learning the
game engine, motivation was improved, and this further helped to encourage progress. A summary at

the end of the stage acted as a reinforcement of what had been done to ensure memory retention.

The final element of the Unity tutorials was the progress checks and marking off each completed step.
As seen in Figure 19, at the end of each tutorial step, an interactive button allowed the user to mark a

completed action. This periodically provided a rush of dopamine, thus creating a sense of reward.

You should now be able to look around your room with your mouse and
keyboard using the Device Simulator.

If you want, you can also download the Rig_Simulator Keyboard Shortcut Cheat
Sheet.

Mark step as completed

Figure 19: Unity Learn "Mark step as completed” function
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Once a step was complete, it lit up as green on the progress bar on the page, seen in Figure 20. Even
though this is particularly beneficial to visual learners, most learners benefit from having a sense of
where they are within a tutorial. It helps pace yourself and again provides a dopamine hit as you work
through the tutorial, lighting up more steps green. The progress bar and the associated colour scheme,

green for completed work, were replicated in the KB.

As shown in Figure 20, the stage of learning is stage 1 — VR Basics. The stage is broken down into sub-
step 1.1, where there are six steps and a recap. By breaking the steps down into smaller blocks, it
becomes more manageable than one very long step. Furthermore, it creates momentum as there are
more dopamine boosts from regularly completing steps. This breakdown of steps was also replicated in

the KB.

Project
1- VR Basics

Tutorial e 1.1 - VR Project Setup

® 1 Open anew VR project
® 2 e Open and explore the starter scene
® 3 e Add a room and background

4 o Test with the Device Simulator

5 e Test in VR through Unity

6 o Build and run on your device

7 e Recap

Figure 20: Progress Bar on Unity Learn Tool

Given how useful and complete the Unity Learn tutorial is, this will be offered in the KB. However, it
is presented with warnings regarding the required time commitment. It will be recommended that users
skip the Unity Learn tutorial for the quicker and more direct tutorials. Still, it is a highly effective

learning tool that should be available for consideration.

The first few Unity Learn modules were also used in the KB. These were modules that demonstrated
setup and testing methods, and therefore did not require completion of prior steps. The tutorials used

are outlined in Table 3.
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Table 3: Unity Learn Tutorials used in the Knowledge Base

Unity Tutorial KB Slide

Introduction to the Unity Editor [53] Introduction to Unity and Navigation

Test with the Device Simulator [54] Troubleshooting: Test Live with Laptop Device
Simulation

Test in VR through Unity [55] Troubleshooting: Test in VR with Oculus Link

Build and run on your device [56] Troubleshooting: Building and Running Unity
Program through ADB

5.3 Experience of Upskilling using other tutorial formats

The following format of tutorial explored was textbooks, as this was an effective learning tool in
literature. But again, problems of rapid development were faced. Having to Google most steps of a

follow-along tutorial was demoralising and prevented any momentum.

Furthermore, unlike the Unity Learn tutorials, textbooks only presented the written steps, with images
to highlight the result. Even if the steps were articulated perfectly, it was harder to absorb the
information presented without the video presentation. Memory retention was much poorer, and it was
casy to disengage. Furthermore, for students with English as a second language, translation issues may

occur and prevent progress.

Next was an attempt to use blogs. Despite blogs being the most up to date of the resources, it was found
that they are primarily used to answer community questions rather than to teach usage of the game

engine.

One blog was used in the knowledge base to explain the installation of ADB Drivers [57]. This source
was comprehensive and only used as an optional supplement to the tutorial if the user wanted additional
detail. Furthermore, there is a note at the start of the knowledge base to take advantage of blogs if there

is any confusion from the KB or a tutorial.

5.4 Experience of Upskilling using YouTube Tutorials

5.4.1 Overview of YouTube Content

Finally, YouTube tutorials were explored. In many ways, this was the closest match to the Unity Learn
tutorials. Most video tutorials were designed as a step-by-step guided method to achieve an end goal.
Most videos had at least English captions, and in the video's comments, questions can be posed, with a

community of users responding.

The greatest downfall of using YouTube was that the quality and relevancy of the video varied greatly

from one creator to another. In this context, a creator is someone who creates and uploads content to

32



Kate O Sullivan
The Development of a Guided Knowledge Base to Effectively Teach Virtual Reality Programming
YouTube. With over 6.7 million videos found when searching “Unity Tutorials”, trying to find a good

set of creators can feel like trying to find a needle in a haystack.

Unlike Unity Learn, filters could be applied to search results. For example, only videos made in 2021
were considered. Secondly, there was a preference to only use tutorials from creators who appeared on
the first result page on YouTube and focused on creators with a high viewer count. When searching for
information online, people rarely look beyond the first page of results. Consequently, tutorials on the
first results page would be the most viewed, and therefore would have the largest community who could

ask and respond to questions in the comments.
Most Unity tutorials tended to fall into one of two categories:

1. Over one-hour tutorials that attempt to introduce all functionalities of Unity

2. A series of videos

Videos over an hour-long are intimidating for new users who often want quick results to build
confidence and momentum. As explained previously, series videos that work in a waterfall fashion are

also a problem, as not all steps may be necessary.

5.4.2  YouTube Creator and Tutorials used in the KB

After significant searching, one key creator was identified: Justin P Barnett [58], shown in Figure 21.

Though other tutorials supplemented his content, most of the KB is derived from his page.
Barnett’s tutorials were selected as they fulfilled critical criteria that seemingly no other creator fulfilled.

Firstly, each tutorial was able to stand on its own and be used in isolation. Hence, relevant tutorials can
be specifically selected for use in the KB. However, the tutorials can be completed within one project.

As a result, users of the KB do not need to repeat the setup process, and computer memory is saved.

Each video is between 20 to 30 minutes long, which is an appropriate length to complete in one sitting

to feel like progress has been made without burning out.

Furthermore, his content is engaging. Barnett speaks with clarity and at an appropriate cadence. His
work is easy to follow, and he often responds to questions in his videos' comment section. He also

bookends his videos with a purpose and summary similar to the Unity Learn content.

All his videos contain subtitles that supplement the video. Unfortunately, these are only in English, but

the video can be slowed down for those who struggle with understanding on the first attempt.

Finally, the content is not only up to date, but he also updates his work as there are minor changes to

the platform.
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JUSTIN P BARNETT @
VR DEVELOPMENT

? Justin P Barnett - VR Game Dev
I a7k subscrivers
HOME 2 PLAYLISTS coMMUNITY ANN A

VR Super Jam 2021 Annous \cemen (. @

Figure 21: Justin P Barnett YouTube Home Page

His content was the most interesting and resulted in the most effective memory retention with all these
factors combined. Therefore, it is the dominant source used in the KB. Additional content was pulled
from other YouTube creators, as well as Unity Learn. An outline of all YouTube tutorials used within

the knowledge base is highlighted in Table 4.

Table 4: YouTube Tutorials used in the Knowledge Base

YouTube Tutorial Tutorial Creator | KB Slide

Oculus Quest 2 VR Headset Unboxing & | Oculus Explore and Set Up your Headset
Setup | Oculus [59]

Create Your Own Virtual Apartment in | AItVR 1. Download Unity Hub

1:1 Scale on Oculus Quest 1 & 2 2. Recreate an environment
(TUTORIAL) [60] in VR: Including models

and textiles
How To MAKE A VR GAME: | Justin P Barnett Create a Unity Scene
Beginner's guide to Virtual Reality &
Unity XR Plugin [61]

How to ANIMATE Hands in VR - Unity | Justin P Barnett Apply hand controllers in Unity
XR Beginner Tutorial (New Input
System) [62]

All About VR Interactables [63] Justin P Barnett VR Interactable Objects

I turned my house into a VR Game [64] | Valem Recreate an environment in VR:
Including models and textiles
Ul Using Unity XR Interaction Toolkit | | Justin P Barnett User Interaction

How to Make a User Interface That

Works in VR [65]

Hand Tracking Updates and Resources | | Oculus Apply Hand Tracking
Oculus For Developers [66]

Unity Hand Tracking with Oculus Quest | KatriSoft Apply Hand Tracking

2 and Ul Canvas — Tutorial [67]
How to Start a VR Game using Unity | Justin P Barnett Updates on Set Up
2021 [68]
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5.5 Decision Process to Determine Required Tutorials

This step was completed in collaboration with Joshua Dawson, as throughout his thesis, he built a VR
simulation specifically for atrial fibrillation surgical training. The objective of the KB is to be a generic

tool for all people wanting to use VR.

Required skills were divided into two sub-categories. Firstly, “Unity Basics” encompassed the skills
necessary for virtually all game developers. The decision for these tutorials was based on experiences

upskilling on Unity.

All other helpful but optional tutorials were listed under “Additional Unity Tutorials”. These additional
tutorials also comprised tutorials specific to Joshua’s project and in the medical field. For example,

calibrating and aligning the physical and virtual worlds.

Two other sub-categories were implemented into the KB. These included “Set Up Headset”, which
incorporate the necessary steps for first-time users of a VR headset, such as tips for the first use of the
headset and connecting the headset to a computer for game development testing. Additionally, there
must be a “Unity Set Up” section describing installing Unity to a computer and downloading the correct

package and modules.

5.6 Future Work

Looking towards the future, most of the KB’s development will be focused on maintaining its relevancy.
As VR technology advances and the Unity game engine releases upgrades to their platform to match,
the KB will need to be regularly monitored and updated to keep relevance. Though only minor changes
affected the platform in recent years, a significant upgrade as was seen between 2019 and 2020 may

render a number of the external tutorials redundant.

Furthermore, proper testing will need to be performed on the entire KB to gain a complete perspective
on its efficacy. Testing should be performed to compare game development learning speed and efficacy
between students using the KB and students finding information independently. Examples of questions
that could be asked during testing is provided in chapter 3.4.2. The goals of such testing should include

discovering:

v" How much faster users can come up to speed with game development on Unity with the KB in
comparison to students learning VR independently without a guide

v" Does the KB provide an excellent introduction to Unity for students to then move on to
developing their virtual reality simulations

v' Is there game development skills that should be added to the KB that are not currently included
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As more students work on VR projects, particularly projects in the medical field, more skills should be
added to the “Additional Tutorials’ section of the KB. By providing easy access to tutorials, students
will be able to catch up to previous students' work quickly, and therefore will have more time to make

significant progressions. Furthermore, students create a Frequently Asked Questions section to the KB.

Finally, quizzes should be added throughout the KB to ensure memory retention, as this was one of the
dominant responses from the survey when asked what makes online learning effective. Adding a quick
quiz asking students about what they should have learnt during the tutorial at either the end of every

tutorial or at the end of each section would be effective.
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Chapter 6 — Conclusion

This thesis focuses on the use of Virtual Reality (VR) as a tool in industry and the role of game
development in learning to use it effectively. The thesis aimed to create a repository of resources for
new VR users to effectively guide them through the initial stages of learning Unity game development.
Particular foci were the use of VR in the medical field and providing resources to help students on

projects.

Various modes of learning were examined and considered in hopes of understanding how people best

responded to them in a VR setting.

As aresult, a 35-slide PowerPoint Knowledge Base (KB) was created. The KB uses up-to-date, reliable
resources that introduce the fundamentals of game development. Consequently, this eliminates the
confusion of entering the VR world and reduces the time spent finding relevant sources for upskilling.

Therefore, students can dedicate more time to developing VR projects.

Preliminary testing demonstrated that the KB helped first time VR users feel more confident and
comfortable using the VR headsets and reduced the time taken on basic tasks, such as adjusting settings
and understanding the controller buttons’ functions. The KB also successfully taught the initial setup
required for Unity game development. The UNSW Immersive Technology Team also described the KB

as ‘comprehensive’ and ‘extensive’.

The use of VR in the medical field was considered and its application promises significant advancement

in the mode of delivery of surgical training and procedures.

Future work must ensure the KB is regularly updated in line with Unity upgrades and VR technology
advancements. Extensive testing also needs to be performed to determine the true efficacy of the
complete KB. Students working on medical projects should also add their own VR learnings to the KB,
perhaps through creating a frequently asked question page, so that future students can quickly come up
to speed with current work and not reinvent the wheel. Finally, interactive elements, such as quizzes

should be added to the KB to ensure memory retention.
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Appendix A — Completed Knowledge Base Slides

Appendix

4 Methed
01 Set Up Headset
Unity VR Game Development Table of
Knowledge Base Contents 02 UnitySetup
Unity Basi
Note to users: This guide is comprehensive, but not 03 nity Basics
exhaustive. For any questions please refer to online blogs and throug
communities, or speak to your project leaders. the complete tu 04 Additional Unity Tutorials
05 Troubleshooting Methods
1 &
Explore and Set Up your Headset Set Up Oculus App
* Before trying on the headset for the first time: « Download Oculus App: https://www.oculus.com/setup/
« Make sure you sure you are in an ares with lots of free space N
+ Ensure you have the correct contraller in each hand, and secure the strap ta your wrist * Open the app and check for the following banner at the top of the
+ Ensure your headset is charged using the USB-C charger (the power light should be app “Your system’s graphics card is incompatible with the Rife System

green software. Learn More”:
« Click here for an introduction tutorial which will outline comfortably fitting the Oculus
headset, set up the guardian, maintenance and care, and navigation in VR

* Place the headset on and turn it on (Power button located next to light when charging)

* Explore the home page, find the settings (ciick here for explanation) to adjust the = M if the above banner appears, or if using non-Oculus headset
+ Otherwise, Mark Step as Complete

volume, home environment, and brightness, and connect to your WiFi
=+ Click here for tips to reduce blurriness when using the headset

+ Hawe fun, plsy some games, and try to et s nstural fesling and
understanding of the headset Lo BN
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01. Set Up Headset

Set Up Headset
# Expiore and Sef Up Your Headsel
Set Up Oculus App
Set Up Oeuus Link
Set Up Using ADB
Set Up ADA Drivers
Set Up ADB Davice Cannecton
Set Up Wireless Connestion

Unity Set Up
Unity Basics

Additional Unity Tutorials

@ Using Oculus Link for Set Up

Click on Devices in the left hand panel

. Select Add Headset

. Select the Oculus model being used and press Continue

. Select Link (Cable) and press Continue

. Wiait for the headset to link and follow any remaining prompts

Do W

* Note: if it does not connect try using different USB-C cables and/or
different computer ports

= Click here if it continues not to work
Mark Step 25 Complete
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@ Using ADB Drivers for Set Up

Android Debug Bridge (ADB) is used to communicate between your
computer and an android device, such as a headset, for debugging. ADB
is the software which lets PCs transfer and install apps onto Android-
based devices like Oculus standalone headsets .

* Download the Oculus Go ADB Drivers and ensure if is saved in a
known location:
o Windows
o Mac
o Linux
* Extract the file

@ OPTIONAL: Enable wireless connection

Enabling wireless connection, that is connecting the headset to the computer over WiFi and without o
cable, is helpful os it meons your gome can be tested with free movement. Howeuer, when first Buildin
Broject, it isoften cosier, quicker, and more refiabie o ee the headse: prysically <G into the
compu

1. Ensure your headsetand adb host computer are connected to the same Wi-Fi

2 Onyour compu Wiff 1P addres: [Settings » Wi-Fi Settings > Advanced/Properties » 1P
Addressj .z 1

3. Connectthe headset to the computer and run 2db as shown praviously

4. Inthe command fine type: adb tcpip 5555

5. Inthe comman nnect tothe IP address from step 2, and type: device_ip_address:5555, for
sxample 192.1 5

6. Disconnect the USE cable and check connection using: adb devices

7. Reconnect by sxscuting in the command line: adb connect
& Reset adb host by sxecuting in the command line: adb kill-server

10

@ Install Unity Module

Adding build support is necessary for the
project to be compatible with o headser, which
is on android device.

d. Press "ADD" in the top right carner of
Instalis page

&. Select the most updated LTS version of
Unity and ensure “Android Build Suppore” and
all child modules are selected when asked to
=dd modules {in screenshot across)

1. Follow the prompts in Unity Hub to continue
downlozding 2nd installing, then wait for it ta
instail

£ When on the Installs tab, the version
downloaded should have zn Andraid ican. If
not, sefect the three dots, select “Add
Madules™ and complete Stap &

@ Example Command Prompt (Windows)

+ Open “Command Prompt” or
Terminal ar 05 shell

* Navigate to platform-tools folder
using “cd” to move forward

* Return 1o start using “cd \*

* Once in platform-tools type
"adb", if a document appears as
seen, then it has been installed
correctly

02. Unity Set Up

@  SetUp Headset
Unity Set Up
# Downioad Unity Hub
Install Unity Module

Unity Basics

Additional Unity Tutorials

03. Unity Basics

Set Up Headset

@ Unity SetUp
@) Unity Basics
@ Introduction to Unity and Navigation
OPTIONAL: In-depth Unity Tutorial
RECOMMENDED- Create 3 Unity Scene
Apply Hand Controllers

R Interactable Chjects

Extra Unity Tutorials
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Connect headset to computer

= If the device does not appear go through to troubleshooting methods

- Connect headset to computer using USB-C cord provided
= Ensure the headset is on, and press to “Allow” media access on the headset
= Run “adb devices" on the Command Prompt

[¥.1

@ Download Unity Hub

. 1 Downlosd Unity Hub

2. Once downloaded, open the
Unity Hub and complate any sat
up procedurs
a. Pressthe Icon in the top right ]
<orner (circled in red) : i
b.  Sign In/Up to Unity
. PressSettings [circled in - =
blue) »> Licence ——
Managsment >> Active New
License

aa
==

w

. Prass“In
calumn |

=" on the left hand
jighted yellow)

© Introduction to Unity and Navigation

ere for an introduction to the Unity Editor

* Navigation in Unity (Click hers for extra detail):
+ Pan: Select the Hand toal in the Toolbar, and click and drag in the Scane view 5o move your view
* Zoom: Holding Alt (Windows) or Option (mzcDS}, right-click and drag in the Scene view to zoom
* Orbit: Holding Alt [Window: tion (macDS), left-click and drag to arbit around the current

i - = not availabie in 30 moy

* Focus Frame Select]: When 2 GameObiject is selected, sslect Fwith your cursor n the Scene view

10 focus your view on that GameOBject. Nate: f your Sursar is Nt in 1he Scens wiew, Frame Select
will not wark

= Flythrough Mode to navigate in scene view:
* Ciick and hold the right mouse button
* Use WASD to move the view left/right/forward /backward.
* Us= Qznd E to move the view up and down.
* Select and hold Shift to move faster.
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OPTIONAL: In-depth Unity Tutorial

For an in-depth, complete, and detailed Unity introduction:

Click here

= Note: this course is a significant time commitment: 23 hours to complete
* These tutarials have the advantage of video and written steps

= Skip tolater slides once these tutorials are complete

RECOMMENDED:

- Quicker tutarials that explore the basics of Unity:  [IGe e e REEE s

@ VR Interactable Objects

22

Click here for tutorial about creating and interacting with VR objects
This is @ continuation of the previous tutorial so can skip setup and use
previous profect
Notes with timestamps:

* 4:30: To select material colour, select the white square across from Albedo

+ 5:30: Click here for link to asset used

* 5:50: To find the Asset List navigate through Window > Package Manager and switch

from “Unity Registry’ to 'My Assets’ at the top of the tab
* If the zsset does not 2ppear: ensure your Unity store and Unity Hub/Project is logged into the
zame account

Once tutorial is complete, select Mark Step as Complete and return to

previous tutorial
Mark Step as Complete

Recreate an environment in VR:
Including models and textiles

Click here for a tutorial looks at recreating environments
It teaches methods of adding textures to blocks and adding in external
models
Tips:
+ Instead of re-building your apartment, focus on just one room
+ The tutorial references using “poly.google” this has been shut down. Instead use:
a. Free3D ( Download 7-Zip to extract .rar files > Tutorial )
b, Unity Asset Store

* Click here and watch the tutorial from 2:45 to 3:40 to see technique on how to

ensure the virtual and real worlds can align

17

Create a Unity Scene

Click here for a tutarial that explores all the basic fundamentals of building a game in
Unity, including packages to download and all set up reguirements

Notes on some updates since tutorial was made:
1. Click here to view the changes in set up since the tutorial
2. When setting up the XR Rig (Action-based), select XR Rig, and then in the inspector change the
Tracking Origin Mode to “Floor”
3. Click one of the Links below for different methods to Build and Run the program

s o it [T—
S Davices ks Sumalatic

Mote: whilst in the game play around with basic objects using the toolbar
{pictured) at the top left corner of the Unity editor to explore useful features

such as the Scale, Move, and Rotation features
You can use Ctri+Z to undo previous staps _ Mark Step as Complete

04. Additional Unity Tutorials

20

23

@  SetUp Headset
|
Unity Set Up

Unity Basics

Additional Unity Tutorials

# Calibration: Aligning the physical and virusal world
Recreste an emironment in VR
User Interaction
Hand Tracking

User Interaction

Click here for tutorial exploring User Interactions, for example, creating
a slider or a button

Some tips that may help throughout the tutorial:
= To set up the project in the Unity Hub select New > Universal Render Pipeline

= When scaling the canvas it may be quicker to just manually enter the values
Pas X: 0.03, Pos Y: 1.6, Rotation Y: 270

= To press two items in the hierarchy at once, press Ctrl and then select items

- 6:35: To change the Invalid Gradient colour, click on the colour, and
individually select the black arrows at the top corners and change the alpha to
zero

44

21

24

Apply hand controllers in Unity

Click here for a tutorial to add hand controllers, controller functions, and hand
animation in Unity

This is a continuation of the previous tutorial so can skip setup and use previous
project.

Meed visual studio? = click here for free download

Motes with timestamps:

1:20: Qlick here for link to downloadable hands model

0: Ensure to ‘uniock’ the left hand model in the inspector

+ 7:10: After opening the animation tab (Window > Animation > Animation) you can drag the
1ab and clip it to the desired section of the Unity screen

+ 23:00: If ‘Spead’ doesn’t appear, ensure you have saved the cods in visual studlo atherwise
Something in the code is wrong = lock for the red fine which indicates mistak

* 24:40: Click here and go to next tutorial and then return to complete lumna|

Calibration: Aligning physical and virtual worlds

The aim of calibration is to create that code allows the user to accurately align
objects in the real world to objects in the virtual world.

Tm: articular method requires the use of the NDI Aurero as it is the most accurate, however, the
ethod can be odjusted to work off controliers alane.

« User process we want to achieve:
1. User starts program and selects begin
User places front of a controller on the front left corner of their workbench and pulls the
trigger

2

3. Repeat 2 for the front right, and back right corners.
4. Calibration complete!

Click here for the process to achieve these assumptions.

The summary of the code is that NDI points get parsed,

coordinates are then modified and then are in the global frame. |:i

Apply Hand Tracking

Turn hand tracking on in your Oculus headset by: Settings > Devices > Hands
and Controllers, then switch Hand Tracking on and follow the prompts

Click here for brief introduction to hand tracking possibilities with the Oculus
headset

Click here for tutorial on adding hand tracking (continue from previous 3D
tutorials).

* Notes with timestamps:

+ 0:30: Click here for Asset Store link to download Oculus Integration.
Add it to your project by navigating Window > Package Manager, selecting My Assets
atthe top bar, then import the Oculus Integration (accept all prompts)

Mark Step as Complete
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Completed!

@  SetUpHeadset
|
Unity Set Up
Unity Basics

Additional Unity Tutorials

25
4 Troubleshooting Methods

Troubleshooting methods to connect headset with adb
driver

* Download the Oculus ADB Driver

+ Toinstall the driver, unzip the package and right-click on android_winush.inf on press “Install® to install the file on
yeur P s hot liztion)

+ Ensure you press “Allow” when access for sccess
- Ifthis pop up dossn’t sppear, in the headsst navigate o Settings > Developer and ensure USB Connection
Dizlogue iz switched on

= Try using a different USB cable or port

= Delete and re-install platform-tools

= Create Oculus profile and create a new organisation

+ Last resort: speak to the UNSW Immersive Tech Team and / or your Project Managers and Team

Academic Leads
Mark Step s Complete.

26
Install android_winusb
o
29

27

30

Calibration Method

Set Up Assumptions {can be adjusted}
* Avector forthe sensar origin is determined from the table corners determined by the user.
* Itis assumad that the NDI field generator is placed in the middle of the tables back edge.

« Table height, depth and width are calculated based an the corner positions.

Vectord = new Vectord| tableCorner=(0] x + [tableWidth /[ 3},
tableHeight + 0.1F, testPinck.tableCorners[0].s + tableDepth — 0.07E);

Click here for the Calibration Code

This code is part of the script attached the empty game object in the scene which handles the TCP

Client.

Troubleshooting: Building and Running Unity Program
through ADB

Click here for video demonstration and detailed steps

Running the program for the first time?-

Navigate through Edit » Project Settings > XR Plugin Management
Select the Android tab and then select Oculus

Mavigate through File > Build Settings

Click Add Open Scenes and add the scene

Ensure the Oculus i turned-on and plugzed in

Click Refresh next to the Run Device (your Oculus should appear)

AT Wl bE

Click Build and Run, then save the project in a new “Builds” Folder

Following that press Ctrl+B to automatically build the project

45

Calibration Code

tempData.rotation.w
tempData.rotation.y
tempData.rotation.x
tempData.rotation.z
v
=
z

posData[0];
posData[l];

posData[2];

—posDatal3];

—posDatal4] + sensorOrigin.y:
—posDatal5] + sensorOrigin.x;
gensorOrigin.z + posDatal€]:

tempData.posi
tempData.position.
tempData.position.

Rotation: Only notable change isthat z = - WDI_z as NDIuse a left-handed coordinate

system, whilst Unity uses a right-handed system

Pasition: x and y values are swapped, then offset.
¥ = -NDI_y + sensorOrigin.x
¥ -NDI_x + sensorOrigin.y
Z = NDI_z + sensorOrigin.z

Troubleshooting: Test in VR with Oculus Link

Click here for video demonstration and detailed steps

1. Navigate through Edit > Project Settings = XR Plugin Management
2. Inthe PC tab select Oculus

3. Connect your device through Oculus Link

4. Press Play at the centre of the top task bar

Return to Calibration
Method
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32

35

Troubleshooting: Test Live with Laptop Device Simulation

+ Click here for detailed steps, mouse controls, tips, and video demonstration

* You can test the scene with a “Device Simulator”

+ This simulator allows you to test the app in-editor using the mouse and keyboard,
rather than having to connect to a device and put it on.

+ This can be helpful for quick tests.

1. From the Project Window, open Samples > XR Interaction Toolkit » [version] = XR Device
Simulator

2. Drag the XR Device Simulator Prafab into he Hierarchy
3. Click Play to test the simulator

= NB: Ensure the Device Simulator is disabled when testing on your headset

Return to Unity Tutorial

Controller Explanation

+ Use the 7. Oculus menu
button on the right hand
controller to pull up the
universal menu to navigate
to settings, change apps etc.

* The Oculus button can also
be used to exit an app

* Button 5. Select Node is also
known as the trigger button
and used to click/select
options

33

Updates on Set Up

Clicl

Click here for tutorial demonstrating these steps

When instalfing the package in XR Plug-in Management (Edit > Project Settings):
) Select OpenxR, rether than Doulus to sccommaodate 2ll headsets
b} Oncs OpenkR s selected there will be 2 waming. Click on the warming and select “Fix AlI"
¢} Oneissue should remain, so select “Edit”

d

under imeraction Profiles ssiect the *=” sign and select 2t ls=st “Dculus Touch Controiler Profile” [ you are
unzure what device will be used, 2150 288 “HTC vive", “Microsoft Motion” and “valve Index”)

& (Cick the Android Tab 2t the top of the screen 2nd repest step € on this separate tab

1] Asturn to KA Piug-in Menagement and £ to the Android Tab. igain select Openi(, cick on the issus that pops
up and select “Fix all’

=) Exit semings and navigste: Window > Packags Manager > OpenX Pluzin, dick into Samples, and Import

Controller Samples
Retumn to Unity Titarial

46

34

Tips to Reduce Blurriness

= Click here for a tutorial to adjust the headset if you are a glasses wearer
+ Adjust the headset to change the eye level
= Adjust the distance between lenses

« For Oculus Quest there is a slider on the bottom left that will adjust the lenses
distance

« For other headset a quick Google search should teach you how to adjust this
* Ensure you are wearing your glasses or contacts (preferable) if your eye
sight is poor
* Clean the lenses with an appropriate glasses cleaner (e.g. microfibre
cloth)

Feturn to Headset.
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Appendix B — Survey Responses

Have you had
experience learning
from home
(university or
school level)?

Yes

Yes

Yes

Yes

Yes

Yes

Yes

What is your preferred
platform for online

learning i.e. which

platform do you find

easiest to use?

Powerpoint

Powerpoint

Powerpoint

Powerpoint

Website

Powerpoint

Powerpoint

What is your
preferred
learning method?

Video tutorials
with follow-along
mstruction

Textbooks

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction
Step-by-step
visual/pictured
instructions

Textbooks

Word Document / PDF  Textbooks

What is your
second preferred
learning method?

Step-by-step
written instructions

Step-by-step
written instructions

Step-by-step
visual/pictured
instructions

Textbooks

Step-by-step
visual/pictured
instructions

Step-by-step
written instructions

Video tutorials with

follow-along
instruction

Step-by-step
written instructions
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When using a
Powerpoint for
learning which do
you prefer?

More slides with
less text on each

Less slides with
more text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

What makes an online learning platform
effective and creates the most memory
retention (e.g. quizzes, demonstration of
examples, an engaging lecturer, repetition,
enjoyment/interest in content)?

engaging lecturer

quizzes/opportunity to participate, and making
sure it’s not too dry (maybe fun or relevant
examples)

Engaging text, visuals, and welcoming vibe

Focus on the big picture/the context in which
the information is relevant. Appropriate
explanation of information and how it links to
material. Test questions. Engagement and
contact with a lecturer/tutor

Kahoot

Memes

Quizzes and open discussions

Engaging lecturer with clear content of the
subject
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Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Word Document / PDF  Textbooks

Powerpoint

Powerpoint

Powerpoint

Powerpoint

Powerpoint

Powerpoint

Powerpoint

Website

Powerpoint

Powerpoint

Step-by-step
visual/pictured
instructions

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
mstruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
mstruction
Step-by-step
written
instructions

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
mstruction

Step-by-step
written instructions

Video tutorials with

follow-along
mstruction

Step-by-step
visual/pictured
instructions

Textbooks

Step-by-step
written instructions

Textbooks

Video tutorials with

follow-along
instruction
Step-by-step
visual/pictured
instructions
Step-by-step
visual/pictured
instructions
Step-by-step
visual/pictured
instructions
Step-by-step
visual/pictured
instructions
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More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

Engaging lecturer with clear concise course
content

engaging content

Quizzes, lots of examples, step by step

Engaging lecturer, examples

Quizzes

interesting content

demonstration

Gamification

Examples of application of the theory being
covered

Engaging lecturer, demonstration of examples

Engaging lecturer, quizzes to be scheduled
AFTER tutorial examples, more preparation
and structure to tutorials



Kate O’Sullivan

The Development of a Guided Knowledge Base to Effectively Teach Virtual Reality Programming

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Website

Powerpoint

Word Document / PDF

Powerpoint

Word Document / PDF

Website

Word Document / PDF

Powerpoint

Powerpoint

Powerpoint

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction
Step-by-step
visual/pictured
instructions

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction
Step-by-step
visual/pictured
instructions

Step-by-step
written instructions

Step-by-step
visual/pictured
instructions

Step-by-step
written instructions

Video tutorials with

follow-along
instruction

Textbooks

Step-by-step
visual/pictured
instructions

Step-by-step
written instructions

Step-by-step
written instructions

Step-by-step
visual/pictured

instructions

Step-by-step
written instructions
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More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

An engaging lecturer who makes classes more
interactive, Enjoyment or unit

interactivity and demonstration of examples

Interactive opportunities to reiterate content
and apply knowledge to questions/scenarios

Demos and exercises, clear explanation with
diagrams

Demonstration of examples and practice

Interesting content, real life examples, quiz
questions

Engaging lecturer and interest in content

Quizzes, interactive content where you
practice the concepts

Interactive modules because they are fun and
stimulate the brain whilst learning content



Kate O’Sullivan

The Development of a Guided Knowledge Base to Effectively Teach Virtual Reality Programming

Yes

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Word Document / PDF

Word Document / PDF

Powerpoint

Powerpoint

Powerpoint

Word Document / PDF

Word Document / PDF

Website

Powerpoint

Powerpoint

Powerpoint

Step-by-step
visual/pictured
instructions

Video tutorials
with follow-along
instruction

Textbooks

Video tutorials
with follow-along
instruction
Step-by-step
written
instructions
Step-by-step
written
instructions

Textbooks

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
mstruction

Video tutorials
with follow-along
instruction

Video tutorials
with follow-along
instruction

Step-by-step
written instructions

Textbooks

Step-by-step
written instructions

Step-by-step
written instructions

Video tutorials with
follow-along
instruction
Step-by-step
visual/pictured
instructions
Step-by-step
written instructions
Step-by-step
visual/pictured
instructions
Step-by-step
visual/pictured
instructions

Step-by-step
written instructions

Step-by-step
written instructions
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Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

Less slides with
more text on each

More slides with
less text on each

More slides with
less text on each

More slides with
less text on each

Short engaging videos, pictures, colour

Quizzes

enjoyment/interest in content, engaging
lecturer

continuous rewards for progress

follow-along demonstration

engaging lecturer that generates interest in the
topic

assessment

examples

examples

enjoyment of content

quizzes



